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1.0 Introduction

As part of the Nine Year Continuous Basic Education (NYCBE), ICT Skills was
introduced as a compulsory, non-core subject as from Grade 5 in 2017. The
assessment is carried out through continuous school - based assessment (SBA)
over Grades 5 and 6. At the end of Grade 6, candidates will have their proficiency

level in ICT Skills given in their Primary School Achievement Certificate (PSAC).

Schools must report on the progress of pupils at the end of each term through
the school report as is the case in other subjects. However, they are not expected
to give marks or grades but rather to give a qualitative appreciation of the
progress of pupils in ICT Skills. The final proficiency level in the subject will be
based on the overall attainment level obtained by the pupils on the different
tasks carried out over Grades 5 and 6 and through continuous observation by

the Educators/ICTSOs on pupils’ progress.

This booklet should be considered, primarily, as a document that provides
shared understanding among stakeholders (educators/ICTSOs, school leaders,
moderators, primary school inspectors mainly) about how to conduct the school-
based assessment in ICT Skills. It outlines the quality assurance procedures in
the process of this assessment in schools to ensure that all pupils are treated
fairly. It also includes the following:

e Instructions to Educators/ICTSOs

¢ Information about the Quality Assurance mechanism

e Exemplar tasks

e Assessment criteria

e A draft sample remark sheet

e A draft sample grading sheet.



2.0 Rationale

According to the Nine Year Continuous Basic Education (NYCBE) Policy
document, “Our education system needs to develop a generation of young adults
equipped with the right knowledge, skills, attitudes and values and with the
following core competencies: critical thinking skills, adaptability and creativity,
ability to work collaboratively, good communication skills and fluency in ICT.” In
the 21st Century, all pupils should have the necessary ICT Skills to function in
society. With the introduction of ICT Skills as from Grade 1, due importance is

being given to this area.

The NYCBE policy document also calls for variety in the modes of assessment. It
is expected that this will reduce the stress that assessment conducted solely
through end of year tests could bring. In this context, and to encourage a hands-
on approach in the teaching and learning of ICT, the SBA assessment in ICT
Skills is conducted through practical activities. The aim of introducing SBA is
primarily to monitor pupils’ learning to improve the teaching process thus

providing continuous support to the pupils.

The assessment should be seen as an integral part of classroom activities.
It is expected that there will be no break in the teaching to start the
assessment but rather that activities being carried out during the normal
teaching-learning process are used to make a judgement on the overall
proficiency level of pupils. It is also expected that the progress of pupils is

taken into consideration while grading the students.

3.0 Guidelines to ICT Educators/ICTSOs

The assessment is based on the National Curriculum Framework (MIE, 2015)
and the Teaching and Learning Syllabus ICT Skills (MIE, 2017). The ICT Skills

textbook is also a useful resource for the assessment. These documents can be
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accessed on the MIE website at www.mie.ac.mu The assessment objectives are

given in the Annual Programme for PSAC 2019 (MES, 2018). Educators/ICTSOs

are expected to be familiar with the above-mentioned documents for their

teaching and for the assessment.

This document contains some guidelines and exemplar tasks covering the
different assessment objectives. Educators/ICTSOs are expected to devise their
own tasks or they can adapt the activities found in the textbook to the objectives

of their assessment.

The following guidelines will help the Educators/ICTSOs in the preparation and

in conducting the assessment in ICT Skills:

1. The assessment is school-based, which means that Educators/ICTSOs are
responsible for planning the assessment, using the appropriate activities

for the assessment and making the assessment judgements.

2. Educators/ICTSOs can use and adapt the assessment criteria provided for
each exemplar task given in this document to make assessment

judgements about the performance of their pupils.

3. The assessment can extend from the 1st term of Grade 5 to the 2nd term
of Grade 6. It should cover at least 4 school terms, ideally, terms 2 and 3

in Grade 5 and terms 1 and 2 in Grade 6.

4. The Educators/ICTSOs are free to decide when to carry out an assessment

(for example: after completion of one or part of a chapter etc...).

5. The assessment tasks can be based on the exemplar materials prepared
by the MES. Educators/ICTSOs can also devise their own tasks or adapt

the activities found in the textbook. The activities used in the classroom
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will be used to evaluate the proficiency level of the pupils on particular

assessment objectives.

. Itis advisable that the total number of assessment tasks over the two years

does not exceed 10.

. The assessment must be carried out during normal teaching hours.

. Educators/ICTSOs are encouraged to carry out at least 1 assessment task

per term.

. The duration of an assessment tasks will depend on the skills being

assessed but are expected to last not more than 15-20 minutes.

10. Resources to be used for assessment tasks should be prepared and

11.

12.

13.

14.

preloaded by the Educator/ICTSO prior to the assessment.

Pupils will be assessed individually on a computer.

It is not necessary that all pupils in a classroom be assessed at the same
time. Depending on the resources available, the class can be split into
groups. The tasks used to assess particular assessment objectives can

also vary.

A portfolio will be kept for each pupil. It will include the:
e Pupil’s work
¢ Evaluation sheets

e Remark sheet

Assessment tasks will be carried with the support of the Head Masters

(HMs) and the Deputy Head Masters (DHMs). The Educator/ICTSO
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should inform the HMs/DHMs prior to conducting an assessment task so

the necessary support can be provided by the school leader/s.

15. The SBA in ICT Skills will be moderated by the Mauritius Examinations
Syndicate.

16. The Educator/ICTSO should keep a logbook/record of the activities used

for the school-based assessment.

4.0 Monitoring of the SBA in ICT Skills

School-based assessment relies on the judgement that Educators/ICTSOs are
making about pupils’ work. This process is consolidated by making sure that the
judgments made are meeting certain set standards. Instead of making an
evaluation of the process at the end only, a constant monitoring at school level
will help improve the assessment exercise. This will improve its strength as a
tool used by the Educator/ICTSO to give valuable feedback to the pupils and to

take necessary remedial actions.

The monitoring exercise relies principally on the roles and responsibilities of the
HMs and/or DHMs with the support of the primary school inspectorate. During
the monitoring exercise at school level, the HMs and/or DHMs should ensure
that:

1. all pupils are being assessed at regular intervals. At least one assessment

is expected to be set in each term.

2. all pupils are given a fair chance to show what they have acquired as

knowledge and competencies.

3. the conditions for the assessment to take place are present, that is:



a. Pupils are assessed individually.

b. The equipment is in proper working conditions.

c. Pupils receive the necessary technical assistance in case of any
problem.

d. The Educator/ICTSO is present in the classroom/ICT room during
the assessment.

e. Pupils are given the necessary time to complete their task.

f. The Educator/ICTSO makes the necessary observations and

recordings.

4. all the assessment objectives are covered through the different assessment

tasks.

5. the tasks are set according to the standards.

6. the Educator/ICTSO grades the tasks of all the pupils.
7. the portfolio for each pupil is kept and updated.

8. the SBA is being used as a formative tool; necessary feedback is given to

the pupils and the remedial actions are taken where necessary.

If all the pupils in a class are not taking the assessment at the same time, the
HMs and DHMs should ensure that pupils who are not taking the assessment

are under the necessary supervision.

5.0 Quality Assurance by the MES

The quality assurance mechanism will ensure that the assessment is conducted
in the best conditions. While the monitoring exercise at school level will ensure

that the tasks are carried out in the optimum conditions for the pupils and
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according to the set standard, it will not take into consideration the standard of
the assessment tasks and marking between schools. The quality assurance
process will therefore ensure that the same standard is applied across schools
and that the proficiency level given at the end of the assessment is reliable. The

quality assurance exercise will take place at two levels:

5.1 Monitoring by Resource persons

Resource persons appointed by the MES will conduct monitoring visits in all
schools. Their roles are mainly to ensure that:
1. the SBA in ICT Skills is being conducted
pupils are being assessed regularly
the assessment tasks meet the assessment objectives
Educators/ICTSOs are keeping the necessary records and backups
the Educators/ICTSOs are getting the support from their HMs

the necessary facilities are available to conduct the SBA

No g RN

constructive feedback is provided to the educators/ICTSOs where

necessary

The resource persons will report back to the MES. Wherever necessary, the MES
will intervene to provide the necessary support so that the SBA is conducted in

the optimum conditions.

5.2 The Moderation/Review Exercise

Once the final proficiency levels of pupils are submitted to the MES, a moderation
exercise will be carried out. This moderation exercise aims at addressing any
discrepancy during the grading of the tasks. The portfolio of pupils kept at
schools should be readily available to the MES resource persons when required.
In case of any issue, additional support, in terms of training, can be provided to

schools.



Figure 1 outlines the quality assurance mechanism.

The resource persons will visit
schools to see whether the
system put in place is working

The feedback will indicate the
weaknesses and the MES, along
with the Ministry will address these.

Moderation . |\ qcration will
of the final be carried out.
grades

Additional support to
schools and Educators
wherever required.

Feedback on
moderation

Figure 1: The Quality Assurance Mechanism

6.0 Exemplar tasks

Educators /ICTSOs are expected to carry out activities to be used as assessment
as and when they feel the pupils are ready on particular learning objective/s.
While Educators/ICTSOs are free to devise their own tasks, it is important that
the standard is maintained in line with the learning and assessment objectives.
Educators/ICTSOs can choose to assess one or more objectives in a particular
task. The assessment should as far as possible be a normal activity in the
classroom. It can be seen as an evaluation of the learning that has taken place

at the end of a topic or an evaluation of the skills acquired after some time.

Some basic assessment criteria will be found in most of the tasks, for instance,
opening software, working healthily and safely in a computer room, keyboarding

or mouse skill. The following are some exemplar tasks to guide the
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Educators/ICTSOs in the development of their own assessment tasks.
These tasks are examples of how the learning outcomes can be assessed.
The tasks can be adapted according to the operating system and the
specifications of the computers available in the school. The
Educators/ICTSOs can also devise their own activities to be used as
assessment. The detailed assessment criteria are provided only as guidance
to Educators/ICTSOs.

6.1 Exemplar Task 1

Learning Objectives:

a) Work safely and healthily in a computer room environment
b) Manipulate desktop elements

c) Mouse skills

d) Keyboarding

e) Opening a software

f) Saving a file

Task:

Sit properly and safely in front of your computer.
Switch on the computer.

Create a folder on the Desktop.

Name the folder “name of pupil”.

Open Microsoft Word.

Type the following text: “Computer”

No R b=

Save the work with file name “Computer 1” in the folder you created
above.
8. Close all open windows.

9. Safely switch off the computer.

10



Assessment criteria:

Name of Educator/ICTSO: Sig:
Name of pupil: Index no

~ R =
Assessment criteria: 20

Sit properly and safely in front of your computer.

Pupil sits as per recommended sitting Posture

Switch on the computer.

WIN

Create a folder on the Desktop.

Holding mouse properly.

Using the right mouse button to click.

Clicking the “New” option on the menu.

Name the folder “name of pupil”.

Typing the name of the folder.

Open Microsoft Word.

|

Type the following text.

Using of Spacebar.

Using of Backspace key and Delete key.

Using of Caps Lock key.

Typing symbols using Shift key.

Using of Enter key.

Save the work with file name Computer 1 in the
folder you created.

Clicking on Save / Save As button.

Selecting the correct folder.

Typing the correct filename in the filename box.

Clicking on the Save button.

Clicking on office button

Close all open windows.

Safely switch off the computer.

Clicking on Shut Down button.
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6.2

Exemplar Task 2

Learning Objectives:

a)
b)
c)
d)
€)
f)
g)

Task:

Page formatting

Identifying the word window
Keyboarding

Image manipulation

Concept of file and folders

Enhancing a word-processed document

Saving a file

Scenario

Your school will be organising its annual as Sports Day.

You have been asked to design a poster for this event using Microsoft Word.

N

o 0ok W

. Use portrait orientation to design the poster.

. The title of the poster “Sports Day 2020” will be centered at the top of the

page. Use Word Art for the title.

Insert the picture sports.jpeg from the folder Sports Day under the title.
Move the picture sports.jpeg so that it is found in the centre of the page.
Increase the size of the picture sports.jpeg

Insert the following text under the picture:

Date: Friday 2274 May 2020
Time: 10.00 a.m
Venue: Football Playground

. Insert a page border of your choice to your poster.

8. Save your poster using the file name Sports Day Poster in My Documents.
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Assessment criteria:

Name of Educator/ICTSO:

Name of pupil:

Assessment criteria:

1 | Use portrait orientation to design the poster.

2 | The title of the poster “Sports Day 2020” will be
centered at the top of the page. Use WordArt for
the title.

Clicking on the Insert tab.

Clicking on WordArt icon.

Clicking on a Word Art of his choice.

Entering title using WordArt dialog box.

Moving the WordArt to the centre of the page

3 | Insert the picture sports.jpeg from the folder
Sports Day under the title.

Clicking on Picture icon.

Locating and open Sports Day folder.

Inserting picture sports.jpeg

4 | Move the picture music.jpeg so that is found on the

centre of the page.

Wrapping picture.

Moving picture to the centre of page.

S | Increase the size the picture sports.jpeg

Resizing picture

6 | Insert text.

Inserting symbol using Shift Key

Using Superscript

7 | Insert a page border of your choice to your poster

Clicking on Page Layout tab

Clicking on Page Borders icon

Inserting a black box border

Inserting coloured /Art border

8 | Save your poster using the file name Sports Day
Poster in My Documents.

Using correct file name.

Saving the document in My Documents.
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6.3 Exemplar Task 3

Learning Objectives:
a) Opening a software
b) Entering data
c) Manipulating rows and columns
d) Performing arithmetic operations in Excel
e) Replicate formula

f) Saving a file

1. Open Microsoft Office Excel.
2. Select a blank workbook.

3. Enter the following without leaving any row and column blank:

B d - =

FILE HOME [MSERT PAGE LAYOUT FORM

C- T 4 -
= Cut Calibri -l - A
2 Copy ~

Paste - | EEE -

- ¥ Format Painter B I U - O "{
Clipboard T Faont

E9 - i I
A B C D E

1 |Monthly Rainfall

2 January February March Total

3 |Vacoas 120 105 82

4 |Albion 45 49 a3

4. Save your work in your folder using file name Rainfall.
5. Merge and Center align Cells A1:E1.

6. Add a row after row 4 to show the following:

Flacq 91 88 70
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region of Vacoas. (Total = January + February + March)

rainfall for the regions of Albion and Flacq.

9. Save your work in your folder.

10. Close Microsoft Office Excel.

Assessment criteria:

Enter a formula in cell E3 to calculate the total amount of rainfall for the

Copy the formula in cells E4 and ES to calculate the total amount of

Name of Educator/ICTSO:

Sig:

Name of pupil:

Index no:

Assessment criteria:

&) ()

C et

—

Open Microsoft Office Excel

Select a blank workbook.

WIN

Entering data correctly in the spreadsheet without
leaving any row and column blank.

Entering Monthly Rainfall

Entering appropriate Month in the correct column

Entering appropriate data in row 3

Entering appropriate data in row 4

Save the work folder using file name Rainfall.

Merge and Center the title in cell Al to E1.

Correctly selecting the range of cells.

Clicking on the Merge and Center icon

Add a row after row 4

Insert appropriate data

Enter formula in cell E3

Select appropriate cells to calculate formula

Click on Autosum icon

Copying formula to cells E4 and ES.

Correctly placing pointer to Fill cells.

Correctly filling cells with formula

Save your work.

Close Microsoft Excel.
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6.4 Exemplar Task 4

Learning Objectives
a) Opening a software
b) Identifying the different areas of a presentation software
c) Keyboarding
d) Mouse skills
e) Creating a simple presentation with more than one slide
f) Creating a presentation which includes animation, themes and slide transitions.

g) Saving a file

Task

Scenario

You have been asked by your teacher to prepare a presentation on “The

Seaside of Mauritius”.

Your presentation must include:
a) Four slides
b) The title of the presentation and your name.
c) Pictures of seaside

d) Name of the seaside

Open Microsoft PowerPoint.

2. On the first slide enter the title: Seasides of Mauritius and your name
as subtitle.

3. On the second slide insert the picture of Belle Mare found in the folder
named seasides on the desktop.

4. Type the name of the seaside as title.

16



5. On the third slide insert the picture of Blue Bay (same folder) and type
the name of the seaside as title.

6. On the fourth slide insert the picture of Mon Choisy (same folder) and
type the name of the seaside as title.
Apply a theme of your choice to your presentation.
Apply a transition to the slides.
Save the work with file name “Seasides” in My Documents.

10. Run the slide show of your presentation.

11. Close all open windows.

Assessment criteria:

Name of Educator/ICTSO: Sig:
Name of pupil: Index no:
Assessment criteria: 28 (@8 &

é Vé )

1 | Open Microsoft PowerPoint.

2 | On the first slide enter the title: Seasides of
Mauritius and your name as subtitle.

Title correctly typed.

Subtitle correctly typed.

3 | On the second slide insert the picture of Belle
Mare and type the name of the seaside as title.

Second slide inserted.

Correct picture inserted.

Name of the seaside typed

4 | On the third slide insert the picture of Blue Bay
and type the name of the seaside as title.

Third slide inserted.

Correct picture inserted.

Name of the seaside typed

S | On the fourth slide insert the picture of Mon
Choisy and type the name of the seaside as title.

Fourth slide inserted.

Correct picture inserted.

Name of the seaside typed
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Apply a theme of your choice to your
presentation.

Theme applied correctly

Apply transition to the slides

Clicking on Animation Tab.

Clicking on a Transition.

Clicking on Apply to All

Save the work with file name “Seasides” in My
Documents.

Clicking on Save / Save As button.

Selecting the correct folder.

Typing the correct filename in the filename box.

Clicking on the Save button.

Run the slide show of your presentation.

Using any method to start slide show.

Using arrow keys to move from one slide to another.

Exit slide show.

10

Close all open windows.

6.5

This

internet connectivity. It is to be carried out only if this part of the teaching

and learning syllabus has been covered and if connectivity is available.

Exemplar Task 5

task is an example of an activity that can be carried out when there is

Learning Objectives

a)
b)
c)
d)
e)
f)
g)

Identify and open a web browser

Identify features of a software (web browser)

Open and navigate a specific website using a web browser

Navigate through a website using hyperlinks
Purposefully search the internet for information
Saving a file

Mouse skills
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Task

Scenario

You have been asked by your teacher to search for information on the internet.

1. Use Search Engine (example Google) to:
a) Search for a picture of a Car.
b) Search for information about four wheels vehicles.

2. Save the picture of the car in the subfolder Images found in the folder
Vehicles on the desktop.

3. Save the information about four wheels vehicles in the subfolder
Information found in the folder Vehicles on the desktop.

4. Close all open windows.

Assessment criteria:

Name of Educator/ICTSO: Sig:
Name of pupil: Index no:

e -
Assessment criteria: | 0”9‘ | O

y A
AR . &r
(LW k
| = s 4

3 ). { 4
=

1 | Use Search Engine to Search for a picture of a car.

2 | Opening a web browser.

Typing google.com in the address bar.

Website correctly opened.

Typing car in the search box and click on search.

Using hyperlinks to move to a specific website.

Finding the appropriate picture.

3 | Save the picture of the car in the subfolder Images
found in the folder Vehicles on the desktop.

Right Click on the picture and click on Save image as

Selecting the correct folder.

Typing the correct filename in the filename box.

4 | Clicking on the Save button.

Search for information about four wheels vehicles
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Returning to homepage.

Correct use of search box to search for information on
car.

5 | Save the information about four wheels vehicles in
the subfolder Information found in the folder
Vehicles on the desktop.

Right Click on the webpage and click on Save page as

Selecting the correct folder

Clicking on the Save button.

6 | Close all open windows.

6.6 Exemplar Task 6

Learning Objectives

a) Opening a software

b) Keyboarding

c) Enhance a word-processed document through the use of header/footer,
subscript/superscript, bullets and numbering, line spacing and page
formatting

d) Can edit text

e) Perform proof-reading through spelling and grammar check and
thesaurus

f) Saving a file

g) Mouse skills

Task

Scenario

You have been asked by your teacher to prepare a list of hobbies using
Microsoft Word.

1. Open Microsoft Word.
2. Type the following text:
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The Wolf’s Story

The boy shouted, “Wolfl Wolf!” The villagers came to help the boy

and found nothing. “Don’t cry when there’s no wolf boy!”, they said

angrily and left.

After a while, he saw a real wolf and cried loudly, “WOLF! PLEASE

HELP! The wolf is chasing the sheep. Help!”

Type your name on the right section of the Header.
Type your class on the left section of the Footer.

Change the page orientation to landscape.

Change the line spacing of text to 2.0.

Replace the word sheep by deer in the last sentence.

3
4
5
6. Set the page margin to wide.
7
8
9

Do a Spelling & Grammar check.

10. Save your work with the file name “Wolf” in My Documents.

11. Close all open windows.

Assessment criteria:

Name of Educator/ICTSO:

Sig:

Name of pupil:

Index no:

Assessment criteria:

.

s

/'7 \\\
- - A\

—

Open Microsoft Word

2 | Type the following text:

Text typed completely

3 | Type your name in the Header.

Clicking on the Insert tab

Clicking on Header button

Clicking on Edit Header

Typing name
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Type your class in the Footer.

Correctly move to Footer section

Typing class name in Footer

Change the page orientation to landscape.

Clicking on the Page Layout tab

Clicking on Orientation button

Correct orientation selected

Set the page margin to wide.

Clicking on Margin button

Correct margin selected

Change the line spacing to 2.0.

Selecting the list

Clicking on the Line Spacing button on the Ribbon

Clicking on 2.0 in the list which appear

Erase the word sheep and replace by deer in the
last sentence.

Correctly erases the word sheep

Typing the word deer

Do a Spelling & Grammar check.

Clicking on the Review tab

Clicking on the Spelling & Grammar button on the
Ribbon

11

Save the work with file name “Wolf” in My
Documents

12

Close all open windows

7.0 Final Award of Proficiency Level

The proficiency levels, ‘Basic’, Intermediate’ and Proficient’ are used for the
award of the final proficiency level in ICT Skills. The final proficiency level is
based on the overall judgement made by the Educators/ICTSOs on the level
reached by the pupil. Apart from the levels noted on the different tasks, it is
expected that the pupil’s progress over the two years is also taken into
consideration. For instance, if the pupil had difficulty in using ‘Microsoft Word’
at the beginning of the year but is much more at ease with the tool after some
time, this should be reflected in the final level awarded. Educators/ICTSOs

would thus be required to fill in a ‘remark sheet’ to justify the final level awarded

to the pupil.
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The following table gives a descriptor of each level.

7.1 Level Descriptors

Proficiency level

Descriptor
The pupil can:

Proficient

work across several applications simultaneously.
locate, move and delete files and folders.

enhance a word-processed document through the
use of header/footer, subscript/superscript,
bullets and numbering, line spacing and page
formatting

perform proof-reading through spelling and
grammar check and thesaurus

manipulate data in a Spreadsheet software.
perform arithmetic operations by using and
replicating formula.

create presentations which include animation,
themes and slide transitions.

purposefully search the Internet for information.
perform simple image manipulation.

observe all the safety rules when working on a

computer and in a computer room.

Intermediate

use a keyboard to select a text.

manipulate desktop elements.

create, name and rename files and folders.

edit text.

format text.

perform  operations on = worksheets and

workbooks.
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create a simple presentation with more than one
slide.

open and navigate a specific website using a web
browser.

save a file.

show awareness of the safety rules when using a

computer room and a computer.

Basic

make basic use of the mouse.

make a basic use of the keyboard.

identify the different areas of the desktop.
understand and differentiate between files and
folders.

open a software.

identify the different areas of a software.

identify and open a web browser.

navigate through a website using hyperlinks.
show basic knowledge of the safety rules when in

a computer room environment.

Educators/ICTSOs/can use the following for the award of the overall proficiency

level attained:

e To be awarded a Proficient level, a pupil must achieve at least 3 of the

assessment objectives at Proficient level, at least 4 of the assessment

objectives at Intermediate level and at least 5 of the assessment

objectives at Basic level.

e To be awarded an Intermediate level, a pupil must achieve at least 4 of

the assessment objectives at Intermediate level and at least 5 of the

assessment objectives at Basic level.

e Otherwise the pupil is awarded a Basic level grade.

24




7.2 Examples of Allocation of Proficiency Levels

Three scenarios are given to illustrate the award of the different proficiency

levels. These scenarios are based exclusively on the judgements made by the

Educators/ICTSOs during the assessment. It does not take into consideration

the progress that the pupils might have undergone from the first task to the last

task which can also influence the final proficiency level given.

Example 1: Achievement of Proficient level

Level of
Proficiency

Assessment Skills

Pupils
Achievement

R ) 3

D))

vy

s

Proficient

. Work across several applications

simultaneously.

. Locate, move and delete files and folders.

. Enhance a word-processed document

through the use of header/footer,

subscript/superscript, bullets and
numbering, line spacing and page
formatting

. Perform proof-reading through spelling and

grammar check and thesaurus

. Manipulate and analyse data in a

Spreadsheet software.

. Perform arithmetic operations by using and

replicating formula.

. Create presentations which include

animation, themes and slide transitions.

. Purposefully search the Internet for

information.

. Image manipulation.

. Using Keyboard to select a text.
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Intermediate

Manipulate desktop elements.

Create, name and rename files and folders.

Can edit text.

Can format text.

AN NI NI N

oA I ol I

Perform operations on worksheets and
workbooks.

Create a simple presentation with more than
one slide.

. Open and navigate a specific website using

a web browser.

. Saving a file.

Basic

. Mouse skills

. Keyboarding.

3. Identify the different areas of the desktop.

A RN R

>

Understand and differentiate between files
and folders.

Opening a software.

<

Identify the different areas of a software.

Identify and open a web browser.

N o @

Navigate through a website using
hyperlinks.

Work safely and healthily in a computer

room environment.

Level of Proficiency | Requirement | Achievement

Proficient At least 3 4
Intermediate At least 4 6
Basic At least 5 7

PSAC ICT Skills Level: Proficient
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Example 2: Achievement of Intermediate level

Level of
Proficiency

Assessment Skills

Pupils
Achievement

‘9“9\

é wy

Proficient

. Work across several applications

simultaneously.

. Locate, move and delete files and folders.

. Enhance a word-processed document

through the use of header/footer,
subscript/superscript, bullets and
numbering, line spacing and page
formatting

. Perform proof-reading through spelling and

grammar check and thesaurus

. Manipulate and analyse data in a

Spreadsheet software.

. Perform arithmetic operations by using and

replicating formula.

. Create presentations which include

animation, themes and slide transitions.

. Purposefully search the Internet for

information.

. Image manipulation.

Intermediate

. Using Keyboard to select a text.

. Manipulate desktop elements.

. Create, name and rename files and folders.

. Can edit text.
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5. Can format text.

workbooks.

6. Perform operations on worksheets and

one slide.

7. Create a simple presentation with more than

web browser.

8. Open and navigate a specific website using a

9. Saving a file.

Basic

1. Mouse skills

2. Keyboarding.

3. Identify the different areas of the desktop.

and folders.

4. Understand and differentiate between files

5. Opening a software.

6. Identify the different areas of a software.

7. Identify and open a web browser.

hyperlinks.

8. Navigate through a website using

9. Work safely and healthily in a computer
room environment.

Level of Proficiency | Requirement | Achievement
Proficient At least 3 2
Intermediate At least 4 5
Basic At least S 5

PSAC ICT Skills Level: Intermediate
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Example 3: Achievement of Basic level

Level of
Proficiency

Assessment Skills

Pupils
Achievement

B =9 (N

o

Proficient

. Work across several applications

simultaneously.

. Locate, move and delete files and folders.

. Enhance a word-processed document

through the use of header/footer,
subscript/superscript, bullets and
numbering, line spacing and page
formatting

. Perform proof-reading through spelling and

grammar check and thesaurus

. Manipulate and analyse data in a

Spreadsheet software.

. Perform arithmetic operations by using and

replicating formula.

. Create presentations which include

animation, themes and slide transitions.

. Purposefully search the Internet for

information.

. Image manipulation.

Intermediate

. Using Keyboard to select a text.

. Manipulate desktop elements.

. Create, name and rename files and folders.
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4. Can edit text.

5. Can format text.

workbooks.

6. Perform operations on worksheets and

one slide.

7. Create a simple presentation with more than

web browser.

8. Open and navigate a specific website using a

9. Saving a file.

Basic

1. Mouse skills

2. Keyboarding.

3. Identify the different areas of the desktop.

and folders.

4. Understand and differentiate between files

S. Opening a softw.

are.

6. Identify the different areas of a software.

7. ldentify and open a web browser.

hyperlinks.

8. Navigate through a website using

9. Work safely and healthily in a computer
room environment.

Level of Proficiency | Requirement | Achievement
Proficient At least 3 o
Intermediate At least 4 3
Basic At least 5 4

PSAC ICT Skills Level: Basic

30




7.3 Example of a Draft Remark Sheet

Name of Pupil: Ruaan

Index No: 301/4445/5

Name of ICT Support Educator/Support Officer: Bill Gates

B Pt
Sig:

Remarks:

The pupil had some difficulties with understanding the different tools that can
be used with Microsoft Word. However, with the different activities and the
hands-on practice in class, by the end of Grade 6 he shows a lot more
proficiency in manipulating the tool. Ruaan is good at PowerPoint but had

more difficulty with the use of ‘Microsoft Excel’.

7.4 Example of a Draft Record Sheet

Educators are expected to keep a record sheet detailing the activities they have
carried out with their group of pupils. It should include the main assessment
objectives, the group of pupils concerned with the assessment task and the date
on which the task was carried out. The sheet should also include the signatures

of the ICT Educator and that of the HM.

The following gives an example of a record sheet:
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Example of a Draft Record Sheet

School Name

ABCD Government School

presentation on
the mountains of
Mauritius

Competency Tasks Used Group of pupils Date of
activity
Create a poster for | Sandy, Pravish, 21.09.19
enhance a word-processed ,
the school’s sports | Anaelle, Mega,
document through the use
day Koushal, Tanush,
of header/footer,
) ) Sara, Ilyana,...
subscript/superscript, -
. . Create an Shalena, Manisha, | 28.09.19
bullets and numbering, line | .~ .
spacine and paee invitation card for | Shenaz, Kavesh,
P g pag a school event Gabriel, Josh,
formatting ;
Parvesh, Marie
Spreadsheet to 03.02.20
keep record of the
perform arithmetic expenses on
operations by using and pocket money
replicating formula. Spreadsheet to 10.02.20
keep record of the
use of stationaries
in a school
Create a 20.05.20
presentation on
create presentations which | your favourite
include animation, themes | actors
and slide transitions. Create a 27.05.20

Educator’s Signature: ........c.coooiiiiiiiiiiiiiiiii

Head Master’s Signature: .........cocoiiiiiiiiiiiiiiiiiiiiiiienne,
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8.0 Final Result Sheet

Schools will be requested to submit a final result sheet upon completion of the
assessment. The result sheet will contain the proficiency level of each pupil in
Grade 6 in the school. This result sheet must be authenticated by the HM and
should also be signed by the ICT Support Educator. If more than one ICT Support

Educator has been involved in the teaching, it should be indicated.

The final result sheet will be used by the MES for the input of the level reached
by the pupils. It is therefore important that care is taken for the faithful
transmission of the information. This result sheet will also be used during the

moderation/review process.

The following gives a sample of a final result sheet:
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Example of a Final Result Sheet

MAURITIUS EXAMINATIONS SYNDICATE
PSAC ASSESSMENT 2019

RESULT SHEET FOR GRADE 6 — COMMUNICATION SKILLS AND ICT SKILLS

School: | |
B COMPETENCY LEVEL --------------------
P COMMUNICATION SKILLS o
Index Candidate Name | Gender | Optional | English | French | Optional ICT Skills
Number Core Core

1 | 1004/00000/00 | XXXXX, YYYYYY | B Hindi

2 | 1004/00000/00 | XXXXX, YYYYYY | B Hindi

3 | 1004/00000/00 | XXXXX, YYYYYY | G Urdu

4 1004/00000/00 | XXXXX, YYYYYY | B KM

5 | 1004/00000/00 | XXXXX, YYYYYY | G Tamil

Total: 5

Seal of School

| certify that the above competency levels have been verified and found correct.

Name of Head of School: Signature: Date: I
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